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FCC Radio Frequency Interference Statement

This product has been tested and found to comply with the
limits for a class B digital device, pursuant to Part 15 of
the FCC rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that may
cause undesired operation. The FCC Class B limits are
designed to provide reasonable protection against harmful
interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or
television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.

= Increase the separation between the equipment and
receiver.

= Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

= Consult your point of purchase or service representative
for additional suggestions.

CE Warning

This product satisfies the Class B limits of EN55022, EN55024
and safety requirements of EN 60950.



Disposal of Waste Equipment by Users in Private Union

B

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. Fore more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.

.
As an ENERGY STAR® Partner, Avision Inc. has

determined that this product meets the ENERGY STAR
guidelines for energy efficiency.
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System Requirements

IBM compatible PC 586, Pentium or higher
Microsoft Windows 98SE/Me/2000/XP

USB port 2.0 (compatible with USB 1.1)
At least 100 MB of free hard disk space

At least 128 MB of system memory

A CD-ROM drive

vV V V VY V V
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1. Introduction

Congratulations on your purchase of the color image flatbed
scanner. With this scanner, you can quickly scan documents
in duplex (double-sided) mode to increase productivity.

Before you install and operate the new scanner, please take
a few minutes to read through this manual. It provides
proper instructions for you to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.



1. Scanner Main Unit
2. USB Cable
3. Power Adapter & Power Cord

Note:

1. Only use the AC adapter (SA148A-24V by Sino-American/ HEG42-
240200-7L by Hitron) included in the machine. Using other AC
adapters may damage the machine and void the warranty.

2. Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.
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2. Scanner Installation

Precautions

m  Keep the scanner out of direct sunlight. Direct
exposure to the sun or excessive heat may cause
damage to the unit.

= Do not install the scanner in a humid or dusty place.
®  Be sure to use the proper AC power source.

m  Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

=  Retain the scanner box and packing materials for
shipping purposes.



2.1 Removing the shipping lock

Unlock the scanner by moving the lock switch beneath it to the
“Unlock” position. (Refer to the Lock/Unlock figure on the right
side.)

Lock f i
0CK | = .
- - - e —. - .
— .
Unlock — : ‘
'n m

2-2
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2.2 Installing the Scanner Driver and Cables

Note:

1. The Windows system CD may be required when installing
on some PC’s.

2. To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

2.2.1 Connecting to Power
Plug the small end of the power adaptor into the power jack of

your scanner. Insert the other end to an appropriate power
outlet.

=

Power Cable



2.2.2 Turning on the Scanner

The power is controlled by a toggle switch on the side of the
scanner. To turn on the scanner, press the switch toward

"1,

2.2.3 Installing the Scanner Driver

Place the supplied CD-ROM onto your CD-ROM drive.

The software installation graphic appears. If not, run
“setup.exe”.

€1 Setap

Avision

Install Bution Manager
Install Scanner Driver

obe Reader
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3. Choose Install Scanner Driver to install the scanner driver.

2.2.4 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port of
your computer.

2. The computer should detect a new USB device and prompt a
“New Hardware Found” message.

New Hardware Found

USE Scanner

Wwindows has found new hardware and is locating the software for it.

(Windows 9X/Windows ME)



3. In Windows 98SE, Windows ME, or Windows 2000,
confirms that the “Search for a better driver.” is
selected and click the “Next’ button.

Add New Hardware Wizard
‘windows has found the following rew hardware:
USB Seanner
Windows can autamatically ssarch far and install saftware
that supports your harcware. If your hardwars came wi

installation media. insert it now and click Next

twihat would you like to do?

" Wultomatic search for a bette driver (Fecommendedt

" Specily the location of the diiver [dvanced)

il [ mews | cancel

In Windows XP, click the Next button to continue. When
the XP certification screen appears, click Continue
Anyway to complete the installation.

4. When the Finish dialog is prompted, click the Finish
button.

5. Click “View Manual” to view or print the detailed user
manual for the scanner and bundled applications
respectively.

Note:

To uninstall the scanner driver in Windows XP or Windows 2000, be
sure to keep your scanner connecting to your computer.
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3. Completing Your First
Scan

3.1 Loading Your Paper

Align the document to the reference mark, as indicated.

A

Reference mark —/ .
g/g. \\

3-1



3.2 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start=Programs=>Avision AVxxx Scanner=>Avision
Capture Tool.
The Select Scanner Model dialog box will be displayed.

Select Scanner Model EJ
Diiver Type:

mwvan |
LIS |

Scanner Model:
AVIZ]

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.
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5.

Fit Actual
Page Size

[ Avision Capture Tool (TWAIN) - Avision AVxxx
File View About

‘E?Semp s %‘Fulanmmr ENE IV:ZC\_M}/_SCan\_Imﬁge

| |

| . l Save File Path
File Format

Scan

Setup

Choose your desired file format from the File Format drop
down list box. (Default is BMP, other choice includes TIFF,
GIF, and JPEG.)

Type your desired folder name and file name in the File
Path box. (Default is C:\My Scan\Image.)

Note: If you do not wish to save the scanned image,
deselect the Save button since default is Save Enable. In
this case, the thumbnail view will be disabled. And
therefore, after viewing all the scanned images, only the
last one will remain on the screen.

s Bty
Click the Setup button (qu lJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.

3-3



10.

Scanner Properties @

Image | Compression | Color Dropout | Paper | Preview | Options | Setting | Information |
(@ Rear Color T
[ IFront Gray
Image 7 |lRetny 4 i
N [ [Front B&W
Selection [Reer BW e a4 u o
BOX Contrast 04 | o
Resolution (dpi) 200 - -
Invert Black on Hhite Fi
Soan Souree: [Atomatic =]
Profiles |Cmm ﬂ
Defaults... oK Close

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

\ﬁ' Sran .
( ) or choose Scan from the File menu.
The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.
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B2 Avision Capture Tool (TWAIN) - Avision AVxxx |ZHEHX‘

File View About
% FiForwat: |BMP | [Cimy Scanymage | ‘EH D

<

i
=

==

———
ﬁ
===

A | mitmm o e

File Name Image 001 binp, Imsge Type:Color, Width:1640, {engih:2339, Resolution:300 dpi, Image Seze:11507 88 Kbytes

' Status Bar ' Fit Page View

Thumbnail View

11. You can view the scanned image in Fit Page (|QL or

Actual Size (100%) button (D ) from the Viewing toolbars
at the right side.

12. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.

3-5



3.3 A Glance

of the Scanner Properties Dialog Box

Scanner Properties E|
1 —Image | Compression | Colox Dropout | Paper | Ereview | Options | Setting | Information |
o Sz [Domasic sl =]
£ = 2
2 [ Rear B&W A i) 3
J 1L
Resolution {3pi): 200 Ei— 5
Tnvert |Black on White =] 6
Sean Source: [ Antomatic -] 7
Profiks | [Costom 1=
8 Telsils, Sean Clow

1. Tab Options |[Choice: Image, Compression, Color Dropout,
Paper, Options, Settings, Information.

2. Image Choose your image type and the side of
Selection Box |[document you wish to scan. Options vary
based on type of scanner.

3. Brightness: Adjust the brightness level from —100 to +100.

4. Contrast Adjust the contrast level from —100 to +100.

5. Resolution Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source |Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

8. Defaults Reset all values on the tabs to the factory

default settings.

3-6
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

Scanner Properties El

Image NCD]TADIBWDD] Colox Dmpuul] Paper ] vamw] Ophunsl Beting I InIurmath]

E?:fccﬂtr Binarizstion: [Dymamis Threshold =]
R g g s
CiRear B Al wl
il I
Resolution (@pi): [200 =1 |
Tnvert [B1ock om hite |
Sran fowee: [ Antomatic =]
Profiles | [Custom =]

The Scanner Properties dialog box



4.1 Buttons on the Scanner Properties Dialog Box

Scanuer Properties X
Imége | Compression | Color Dropout | Paper | Preview | Options | Setting | Information |
CJFront Color
CJRear Color Biinarization: | Dymamic Threshold =l
ety 4 &
[CRear B&W Al |
il o
Resolution (dpi): 200 Rd J
Tvert [Black on Whits =l
Sean Source: [ Automatiz -]
Profiles | [Custom ~]
e | Coe |

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Scan After all the scan settings are satisfactory, click
the Scan button to start scanning your
document.

Close Click the Close button to leave the Scanner

Properties dialog box.
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The following table shows the default settings :

Tab name Default settings

Image Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression | None

Color Dropout | None

Paper Cropping : Automatic
Deskew : Yes

Orientation : Portrait
OverScan : 0.00

Multifeed Detection : None
Unit : Inch

Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > 0 mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes

4-3



4.2 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

Scanner Properties El
Image ICompIesswn] Color Dmpout] Paper ] Preview ] Optmns] Retting ] Informah.on]
[CFeont Color .
[R.ear Calor Binaxization: | Dymamic: Threshold ~|
[ Fromt Grragy
[ Reax Gray J J
Front B& W
[CR.eer B&W 4] |
Al o
Resolution {dpi): |QDD ﬂ ®
Trsvert: |B]ack on Whte ﬂ
Sean Sovrce: |ﬂuhmahc ﬂ
Pmofiles |Cmm ﬂ
Scan | Close

The Image tab dialog box
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4.2.1 The Image Selection Box

el The Image Selection box includes
the image type and document side
option. If you wish to scan both the
front side and the rear side of your
color document, you can check both
Front Color and Rear Color at the
same time. Note the options vary
based on type of scanner.

Example 1 : Scanning a two-sided color document, both
sides in color

[wiFront Color
_F.E:Eil‘ Colox
[ |Froit Greaar
[Fear Gray
[ |Front B&W
[ Rear B&W

Side/Image
Selection




Example 2 : Scanning a two-sided color document, one
in B&W(Drop Blue Color : Threshold : 10, Background :
79), the other in color

[ JFromt Caolor "
[wEear Color X
|:|Fr0nt GI&}' Somoe
[JRear Gray ;
% Front B2 W b e
[JRear B&W
) N |
Side/Image
Selection Front Rear
Image Type | Description
Color Choose Color if you wish to scan a color
image for your original in color.
Gray Choose Gray image if your original contains
actual shades of gray.
B&W Choose B&W if your original contains only text|
pencil or ink sketch.

B&W Gray
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4.2.2 Other Image Options

Binarization

Quality

This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Two of the options are Dynamic
Threshold and Fixed Processing.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Fixed Processing: Used for black-and-
white and other high contrast documents.
A single level is set to determine the
black-and-white transition. The threshold
is programmable over the entire density
range. Fixed Processing sets Contrast
to 0. If Fixed Processing is selected,
Contrast is not available.

When you choose “Gray” to be your
image type, the “Binarization” item will
be changed to “Quality” and its option
includes “High” and “Normal”. Choose
“High” to enhance your image and make
your image look brighter.

4-7



Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from 0 to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

200 dpi, 200 dpi,
Threshold:80, Threshold:170,
Brightness: O Brightness: O

4-8
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to +100.

Brightness: -50 Brightness: O Brightness: +50
(Normal)

Contrast: -50 Contrast: +50

(Normal)



Resolution

A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi humber,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the
right side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list.

-
Resolution: 75 dpi

.
Resolution: 150 dpi

4-10



User’'s Manual

Invert

Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“E am not worthy to have you anter my

: that is God, I beg all my brothers - those w
e who work manually, clerics and lay brothers
ards telng humble in all things; not to glorify
r to become interlorly proud because of good w

sametimes says or does in them or through tl
ard:  “Do not rejoice--- in the fact that the de

10 20} Let us be firmly convmced of the fact

Black on White

“I am not worthy to have you enter m

that is God, I beg all rmy brathers - those o
E who work manually, clerics and lay brothe

rds being humble in all things; not to glorify
to becorme Interlorly proud because of good
sometlmes says or does in them or through g
“Do not rejoice--- in the fact that the dd
1 Let us be Airmly convinced of the fa

White on Black
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several inside
pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

Note the options vary based on type of scanner.

4.2.3 Scanning color images

The following options are available for scanning color images.

Brightness
Contrast
Resolution
Invert

4.2.4 Scanning grayscale images

The following options are available for scanning gray images.

Brightness
Contrast
Resolution
Invert

4-12
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4.2.5 Scanning B&W images

The following options are available for scanning B&W images.

Or

Binarization (Dynamic Threshold)
Resolution
Invert

Binarization (Fix Processing)
Threshold

Brightness

Resolution

Invert

4-13



4.2.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

2. Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

Image | Compeession | Color Denpout | Paper | Poreww | Optbons | Seting | Infoemston

Edit Your Profile EEx

e aan of P [Fafiet 3 Deler
. Rename Reset
revert o
Fean Soures. | Anicomane Exit
S Clowe

3. Click “Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Pleaze enter the name of the prafile:

Save Cancel |

4. The new profile will be saved and shown in the “Profiles”
dropdown list box.

4-14



User’'s Manual

To load a profile,

1.

2.

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Your Profile EEX

Profile:

Simplex - B&W, 200dpi
Simplex - Calor, 200dpi
Simplex - Gray, 200dpi

Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profile:

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you
want to delete this profile?” is prompted.

Choose “Yes” to delete or “Cancel” to quit.

4-15



To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Frofile

Profile:

Simplex - B&W, 200dpi

Simplex - Color, 200dpi
Simplex - Gray, 200dpi

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.
Eename a Profile E|

Pleas enter the new name of the profile;

Original Name: |Betey

Wesw Name: |

Cancel |

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:

The preset default profiles include Flatbed, Simplex-B&W, 200
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If
you have a simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.

4-16
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4.3 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4

4-17



Scanner Properties

Image  Compiession ]Cu]m Dropout | Paper | Preview | Options | Setting | Information |

[ |Front Calor
[JResr Color
[ |Front Grayr
[(JFesr Groayr
M Er &

[(Rear Bé&W

Compression;

| @Faine) =
—

Defaults.

Scan Clase

The Compression tab dialog box

4-18
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4.4  The Color Dropout Tab

4.4.1 Color Dropout Selection

Color Dropout tab allows you to drop either of the red, blue, or
green color in your scanned image. If your image contains red
color watermark or background, choose the R (Red) channel
then any red watermark or background will be removed. This
feature is used to sharpen your text when using OCR (Optical
Character Recognition) software.

Note that this function supports only black & white and gray
images. Therefore, be sure to choose any black & white or
gray image type while applying this function.

Scanner Properties 4 ‘

Image | Compression  Color Diopout | Paper | Preview | Options | Setting | Information |
[|Front Calor
[CRear Calnr Calor Dropout: |Remove Red =]
[Front Gray =
Filter Theesholi: I -
% Scan Cloze

The Color Dropout dialog box
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4.4.2 Other Color Dropout Options

Advanced Processing provides two options that can adjust
your scanned image in the best optimal result.

Filter This value is used to determine the color

Threshold which will be dropped out. A lower value will
drop more of the selected color out, while a
higher value will leave more of the selected
color in.

Background The pixel which is higher than the

Level background value will be adjusted to the
lightest point. Adjust the value for both the
Filter Threshold and Background Level to
produce the best optimal result.

Example, slightly adjusting the background value makes
your text more clear.

Original

4-20



User’'s Manual

Remove Blue, Threshold: 20, Background:
255

AME120F: B B IIIEM S MG

Remove Blue, Threshold: 20,
Background Level: 210
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4.5 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

Scanner Properties &l
Image | Compression | Color Dropout  Paper mevww] Options | Setting | Informetion |
Cropping:
& Portrait i
=
= J
= 5 J—l
=
=T
=i o
Crverean: j j
Top: 0,00 Botiom: 0o+
Multi-Feed Detectinn
Addifione] Length Detection: 000+
[~ Btop Seanning after Multi-Feed
Multi-Feed Alarm: (one) = | Bovs
nit; [Enches =1

Defaults... Scan Close

The Paper tab dialog box
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4.5.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Fixed to
Transport, EOP (End of Page) Detection.

Options Description

Automatic Automatic adjusts the cropping window
according to different document sizes. Use
this option for batches of mixed-sized

documents.
Fixed to This feature allows you to define the area
Transport or zone to be imaged. Use for batches of

same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of | This feature allows you to define the area
Page) or zone to be imaged. Use for batches of
Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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Example : Redefine your scan area ( x-offset: 2.25 inches ; y-
offset:1.13 inches)

Scanner Properties X
Imsge | Compression | Color Dropout Paper | Breview | Options | Setting | Information |
Ciopping [Fowd 0 Tromsport 4|
r Scan
Scan Area Qine) -] . Area
& Portrait C Landsape
X Offset, prs = B
T-Offiet = jﬂ
Width s3] D|Sp|ay
Length 7.43-H I~ e H
-~ - window
Overfican = =
Top i nnﬁ Bottom: [ nnj
Multi-Feed Detection
Jdditional Length Detection: 0 Dﬂﬁ
[ Siop Scanning after Mrlti-Feed
Multi-Feed ilarm (Mone) j | Brows
Uit Inches =

Defaults... Scan Close

Original After Fixed to
Transport

The Redefined Scan Area
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4.5.2 Other Paper Selection

Deskew

Use this option to automatically deskew a document.

KOHIKANSH B

i S e Note: If the skew angle is
A F too great, some of the
IE= 55 image may be cut off.

¥ -
| B

- | B8
T e— —
o o '

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choice: None, US Letter- 8.5”x 11”7, US Legal — 8.5” x 14”7,
ISO A4 — 21 x 29.7 cm, ISO A5 — 14.8 x 21 cm, ISO A6 — 10.5
x 14.8cm, I1SO A7 — 7.4 x 10/5 cm, ISO B5 — 17.6 x 25 cm,
ISOB6 —12.5 x17.6 cm, ISO B7 — 8.8 x 12.5 cm, JIS B5 —
18.2 x 25.7 cm, JISB6 — 12.8 x 18.2 cm, JISB7 — 9.1 x 12.8
cm, Scanner Maximum, Long Page.

Long Page:

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be available.
Options: Unlimited, Enter Length (Note: This option varies
due to type of scanner.)
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Choose “Unlimited” if you have a batch of long page document
with unknown length. Choose “Enter Length” to enter the
length and width of your documents or your desired scan size
on documents. This is useful when you have a batch of
documents with the same scan size or a batch of same-sized
documents.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of O indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.
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Example : Additional Length Detection : Set Additional
Length to be 2.02 inches

Scanner Properties |'>_(|
Image ] Cumprewiunl Color Dropout Paper leview I Optiuns] Sething ] Infurmaﬁun}
Cropping: |Fizeed. to Tremsport |
Scan Area S0 A5 - 14
+ Portrait " Landscape
=
=l El »
¥-Offset o= t 2.02
Width: spz] -
Length: 826 W Conter
OverSean: j j
Top 000 Batiom: 000
Multi-Feed Detection
Additional Length Detection: 202}
T AL SN MR P e
Multi-Feed Alam None) = |  Bowe.
Uit [Tnches 3|
Defaults Scan | Close |

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder if multi-
feed is detected.
e Sound Alarm on Multi-Feed:
If this is selected and a wave file is added, the scanner will
produce a sound alarm if multi-feed is detected.
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How to add the sound alarm :

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.

3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.5.3 Relative to Document

Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph, or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, 1SO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’s maximum.)

Tmage | Composssion | Colos Dropout Paper | Pavview | Opsions | Seming | Tadomasion |
1 7T comns T — - |
T
2 | i [BORE- 17 xS em | Wi A red
Poatrat v
Xt wy rectangular
V-Oitt (T I T
| |
Wit 6933 - box
Leagth U F
ChwiSean Left 000 Right om-
Top 0.00- Bomm 000
=]
i
-
1<
it =
Ditsalts Sun Close
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

The Image
Selection
Box

lsage | Compmvaion | Colee Dipent | Paper  Pwviw | Oploes | Zobing | lnsbuomabion |

The selected
image

A black
rectangular
box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

Inage | Compaica | Color Dgont | Fager  Favvirw | Ggtionn | Seting | Informaton

Pt Gy

The Preview
Image

The Preview
Button

5. Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

6. Place your cursor on the Preview window and click your
left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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lmage | Comgevasion | Celor Drspent | Faper  Privirw | Optioen | Seming | lafoemation |

[Grmaca: |
A Cross — ot

: . .
Sign . 4 The
s Relative
5 Area
7 e —
g LY WI%
H :: = == -

&
|

Check the B&W image from the Image Selection box to
scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)

convenient to the rest roums and the exits,  Fiendish “Scor's Maiden,” the sev-
be the time » ie

links
@ man. “Offcial Loch Ness Me

e upinthe nled St marieda St
e ut of o il

[y kol
thwartedbyalackof n!mmndlplh\u money
that circulates in “There wasa ot of
....u. ey of s hvlm oy e itsomobmoneyiaGlogowattaierionie

Jumes
Watt and bridge designers Thomss Tef ithere Nick thinks Scotland as been vietim-
o e, L womdere o Scoland ey the U.Ks mania for concentrating
mig rlt s enginering genas (o bigh  busincs i maoc s, “n Scotand bead

tinational computer companies have. (e

s moch arther

u..nm,mm ppears 0 iy n the Ot Hbrides whee
direcly from Silcon . T cmploys 60 70udo's e ok o 4 e
i mlos oo ot e Wrout Gty Joson oy 5 oo s
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Nick Shelnes is

Scotiand 3

The entire document in B&W The relative area in color
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4.6 The Options Tab

The Options tab allows you to set following additional image
processing settings.

Scanner Properiies &

Image ] Cumpremnl CU].UIDIU]JD\H] Paper 1 Preview Options ]Seﬂmg ] Infurmahun]

Rotation

Rotation Degrees : {one i
Blank Page Removal

[~ Blank Page Removal Threshold.: J

Edge Fill

* White
D 0 Millimeters

" Black

Image Control Options
[ Mirmox

Background Setting
(+ White Backgromnd ™ Black Background

Defaults... Scan | Close

The Option tab dialog box
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Flip Side Select “fanfold” to rotate the image
Rotation of the reverse side to 180 degrees.

This is applied to double-sided
document which are viewed in
portrait are sometime fed into the
scanner in landscape or vice versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of
the reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

K
o
= B >
PR 1z m
g odm e -z B
a = (=]
’gngas i L ﬁgg g
Hiz R < - B
2 2/zl= ’ - Ell
= ’ 58 &
& a.,gx 7 ’f' m% Eﬁ
2I5|= s 7 Es
5 2
2| [% ]
4 g
) ?g
3
88
.B
£

4-34



User’'s Manual

Rotate Image Choose the rotation angle from the
drop down list if you wish to rotate
your scanned image.

Choice: None, 90°CW/((clockwise),
90°CCW((counter clockwise),
180°.

123

¢ C1

Original
Rotate 90°CW

¢ C1

123

Rotate Rotate 180°
90°CCW

Blank Page Check if you wish to remove the

Removal blank page and move the slider to
the left or right to your desired
threshold.
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Edge Check White or Black if you wish to add white or

Fill black edge on the border of your scanned
image. Enter the value from O to 5 mm. Default
value is 0.

Original Edge Fill: 5mm (Black)

Image Check the Mirror box if you wish to reverse the
Control right and left side of your image.
Option

The Mirror Effect
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Background
Setting

This option allows you to set your scan
background.

Choice: White Background, Black
Background.

*This option varies based on type of scanner
and is available for the front page in the ADF
(auto document feeder) only. For the rear
page, only the white background is
available.

3 | B
White Background

3
Black Background
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4.7 The Setting Tab

The Setting tab allows you to set the following settings:

[T —— ®)

Imege | Compression | Color Dropout | Faper | Freview | Options  Setting | Information |

Energy ifaving Control

Al | 15 minnrtes

(o) [
W how Soomming Frogress
W Show Waming Messaze
@ Save Settings after Closing

Defaults... Scan Close

The Setting tab dialog box

Energy Saving
Control

Check the Enable Energy Saver box
and move the slider to the right to set
the amount of time to start the energy
saver after your last action. The range
is from 1 to 720 minutes. The default
is 15 minutes.

4-38




User’'s Manual

Batch Scan | eBatch Scan

Setting To increase the scanning speed, the
scanner first scans a few pages of your
document and then sends these scanning
data to the application. Therefore, during
scanning, the numbers of pages been
scanned on the scanner is somehow
different with the numbers of pages
displayed on your computer screen.
Choose this mode if you wish to complete
your scanning task at the fastest speed.

sPage Scan

If you choose Page Scan, during scanning,
the scanner will first scan only one page of
your document and then send the scanned
data to the application and then scan the
next page and send the next data to the
application, and so on. Therefore, in this
mode, the scanning speed is slower yet this
helps to keep the same scanning progress
between the scanner and your computer
screen.

Note: The availability of this feature varies
based on type of scanner.

Show Check and the scanning progress bar will be
Scanning shown during scanning.
Progress
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Show Warning
Message

Check to show the warning messages
such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings
after Closing

Check to save your scanner properties
settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.8 The Information Tab

The Information tab displays the following system and scanner

information.

Scanner Properties

]

Imege I Cnmpreﬁinn] Calor Dmpnut] Paper I Preview I Optinns] Setting  Information ]

%)

Port Type:
1D/ Address:
Ciptical Resolution.

Scanner Model:
Serisl Number:
FIW Version:
Background:
Bom Date

First Scan:

ADF Pad Count:
ADF Roller Cont:
ADF Comnt:
Flathed Count:
Multifeed Count:
Jam Count:

Report

UsE
UEE
600 dpi

AR

620CH1 065851400052
0190

White Backgromnd
200660

20067744
142 Reset Pad Comnt

138 Reset Roller Count

137

463
3053404277
738247178

Defaults...

Clase

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file (C:\AVxxx) will be
generated. Please send this file to the nearest service center

for trouble shooting.
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The “Reset Pad Count” button |

After scanning approximately 50,000 pages (the number varies
based on type of scanner) through the Auto Document Feeder
(ADF), the ADF pad may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF pad with a new one. (Please
refer to the manual for proper replacing procedure.) For
ordering the ADF pad, please consult your nearest dealer.

After replacing the ADF pad, click the “Reset Pad Count”
button to reset the pad count.

The “Reset Roller Count” button |

After scanning approximately 200,000 pages (the number
varies based on type of scanner) through the ADF, the ADF
roller may be worn out and you may experience problems with
document feeding. In this case, it is highly recommended to
replace the ADF roller with a new one. (Note the replacement
of the ADF roller has to be performed only by authorized
service center. Therefore, please return your scanner for roller
replacement.) After replacing the ADF roller, click the “Reset
Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner. Please consult your nearest dealer for more details.
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5. ISIS Interface operation

The ISIS driver operation method is similar to the TWAIN'’s.
Every function on the ISIS interface screen is briefly
described as below:

Scanner Setlings

Mode: Brightness
|Black and White j * Manual At

Dither: . = [ 128 Default
Halftone 4 - e

Diots per inch: Datken I HNarm I Lighten I =

|300 =] ! | area...

Page Size: LContrast-

[45-148421.0em > | Manual «

FI=DFLT Wersion 55.1.260.851 xu| 1 | 128

Avigion PN Driver V2.01.062402

Mode: Select one of scan modes, including B/W, gray,
color options.

Dither: 5 halftone levels available, can be disabled.
Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.
Brightness: Adjust your scan image brightness or
darkness.

Contrast: Adjust the range between the darkest and the
lightest shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using the Buttons

The following picture shows the 3 buttons and 1 function
screen on the scanner.

Function Screen

Function

Function-Select
Button

Cancel/Stop Button

Scan Button




6.1 Installing Button Manager

To use the buttons on the scanner, you need to install the
Button Manager. To ensure the Button Manager work properly,
please FIRST install Button Manager before installing the
scanner driver.

Installing the Button Manager is easy. Insert the supplied CD
to your CD-ROM drive and follow the instructions on the screen
to complete the installation of the Button Manager.

Button Manager provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.

6.2 Checking the Button Configurations Before Scanning

1. Click the Scan button on the scanner.

2. The Button Panel is displayed in the Windows System Tray
at the bottom right corner of your computer screen.

/ This indicates the scanner model

| B

H @ Archive ]

NS~
——— | [ The Function

E =R Icon

H 15 o (The number of
¥ function icons

-] P | vary based on
—EI - type of

scanner.)
The Button = g;;,,r-— w0 P

lcon
The Button Panel
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

The button
number and —|
name.

The file
format of the
scanned
image. (*The 7]
options vary
based on

Bution Properties gl

Memu | Optinns | Setting

Choose a configuration:

4 n \chh 1 Ve W] B2, 150 A4, 200dpi
..
Chooss a destination

Chaoss a fils fomat [ Adobe PDF Propertes | [ Add/Delete |

type of
scanner.)

The default setting is indicated in highlighted color.

_——

Click to select
options or
setting.

The scan
settings for
the selected
button. (in
this case
button #1).

The destination
application.
(This is the
application that
opens after you
have finished
scanning.)

If you

wish to change the setting, use this window to reset the
setting for the file format, destination application, or other
scan settings. See “Configuring the Button” in the
subsequent section to reset the settings.

4. Click the OK button to leave the window.



6.3 Scanning From One Touch of the Buttons

1.

Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document
feeder.

Check the number on the LED screen to ensure if you are
selecting the proper scan settings and destination
application. (For example, if you want to scan with button
#4, which open roxio PhotoSuite and display the scanned
image in the main window of roxio PhotoSuite, the LED
screen should show 4).

Press the Scan button on scanner.

After the scanning is finished, the roxio PhotoSuite will be
launched and the scanned image appears in the main
window of roxio PhotoSuite as below.

Note:
For details information on how to use the Button Manager,
please refer to the user’s manual in the supplied CD.
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7. CARE AND MAINTENANCE

Soak a cotton swab with some isopropyl alcohol. (95%)

Open the document cover as shown below. Wipe the document
glass by moving the swab from side to side.

Close the document cover. Your scanner is now ready for use.

1. Document glass
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8. TROUBLESHOOTING

If you have problems with the operation of your scanner,
please check the following troubleshooting hints.

8.1 Frequently asked Questions

Question:

Answer:

Question:

Answer:

When the scanner is powered on, it makes noises
and won’t stand ready.

There are two possibilities:

1) You might fail to push the scanner shipping lock
to its “use” position. If this is the case, pull the
scanner status switch to its “use” position first.

2) The scanner is not placed on an even, flat
desktop surface. This may cause the scanner to
malfunction.

The scanner is powered on, but the lamp does not
light up.

The lamp is probably out of order. Contact your
local dealer or distributor to replace the lamp. For
your information, the average life time of the lamp is
about 15,000 hours and the operating temperature
for the scanner is between 10°C(50°F) and
40°C(104°F).
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Question: While scanning, the scanner often makes noises,
or it scans back and forth.

Answer: Usually this means the memory of your computer is
not enough or the speed of your CPU too slow.
Please try to increase your memory to at least 32M
or replace your CPU with Pentium or later.

Question: Why is it that the scanned image always comes
out to be too dark?

Answer: 1) Modify the Gamma setting t01.8~2.2 for your
monitor and, when printing, set the Gamma
setting to 2.2 for your printer.

2) Adjust the Brightness setting from the TWAIN
user interface to get a brighter image.

Question: The scanner works well except for the line art
image. The lines in the image seem to be much
thicker than the original one.

Answer: Increase the Brightness or adjust the Threshold
setting to improve line art image.

Question: When | choose optical resolution to be 650 dpi,
the "auto crop" and "deskew" functions will be
disabled.

Answer: Since to perform auto crop and deskew consumes
great deal of system memory, it is suggested if you
wish to perform "auto crop" and "deskew"

functions,
please choose your optical resolution to be smaller
than 600 dpi to prevent an error message.
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9. Technical Service

Technical support for Avision scanner is provided at Avision
Technical Assistance Center (ATAC). Before contact with
ATAC, please prepare the following information.
Scanner serial & revision number (located on the bottom
of the scanner)Hardware configuration (e.g., your host CPU
type, RAM size, free disk space, display card, interface card,
etc.)The name and version of your software application
The version of your scanner driver.
Please call us at:

US and Canada Area: Avision Labs. Inc.

Address: 6815 Mowry Ave. Newark CA 94560,
USA

Telephone +1 (510) 739-2369

number:

Fax number: +1 (510) 739-6060

Web Site: http://www.avision.com

E-mail: support@avision-labs.com

Other Area: Avision Inc.

Address: No.20, Creation Road I, Science-
Based Industrial Park, Hsinchu,
Taiwan, R.O.C.

Telephone +886 (3) 578-2388
number:

Fax number: +886 (3) 577-7017
Web Site: http://www.avision.com
Email: service@avision.com.tw
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10.

Specifications

All specifications are subject to change without notice.

Model Name

BF-0606H

Scanner Type

Flatbed Desktop scanner

Scanning Mode

24-bit color

256 shades of gray scale
Line Art

Error Diffusion

Optical Resolution 600 dpi

Light Source Cold cathode fluorescent
lamp

Scanning Document 8.5"x 11.69"

Size

Interface USB 2.0

Power Requirements 24Vdc,1.25A

Power Consumption < 36W

Operation Temperature | 5 °Cto 35 °C

Storage Temperature

-40 °C to 60 °C

Dimension

288mm x 480mm x 115mm

(WxDxH)

Weight

6.38 kgs
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